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บทคัดยอ 
 
 ในการจัดทําโครงการเลมนี้จัดทําข้ึนเกี่ยวกับส่ือการเรียนการสอน  Adobe Illustrator CS6 ซ่ึง
ระบบที่พัฒนาข้ึนมาสามารถบันทึกขอมูลของคะแนนแบบฝกหัด และสามารถยอนดูเนื้อหาการสอน
โปรแกรมบทตางๆได 
 ผูจัดทําส่ือการเรียนการสอน  Adobe Illustrator CS6 ไดตระหนักถึงความสําคัญของการใช
โปรแกรม Adobe Illustrator CS6 และเพ่ือใหทุกคนสามารถเขาใจและสามารถใชงานโปรแกรม Adobe 
Illustrator CS6 ไดสะดวกและงายข้ึน ดังนั้นผูจัดทําจึงไดจัดทําส่ือการเรียนการสอน  Adobe Illustrator 
CS6เพื่อตอบสนองความตองการและมุงตรงไปสูกลุมลูกคาตามแบบท่ีทานตองการไดทันที 
 ทายนี้คณะผูจัดทําหวังเปนอยางยิ่งวาส่ือการเรยีนการสอน  Adobe Illustrator CS6ท่ีไดจัดทําข้ึน
จะเปนประโยชนแกผูที่เขามาศึกษาหรือผูที่นําระบบไปใชงานเพ่ือใหเปนแนวทางในการศึกษา 
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กิตติกรรมประกาศ 

 ขอขอบคุณทางวิทยาลัยเทคโนโลยีอรรถวิทยพณิชยการที่เอ้ือเฟอสถานที่ในการจัดทํา
โครงการและการใหขอมูลในการจัดทําโครงการพรอมท้ังหลักสูตรท่ีทําใหคณะผูจัดทําไดมีการ
ประยุกตความรูความสามารถในการสรางผลงานทางวิชาการข้ึน    
 ขอขอบคุณพระคุณอาจารยฐิติรัตน   นัยพัฒน อาจารยท่ีปรึกษาหลัก ท่ีดูแลใหความรู และ        
อาจารยดิฐประพจน   สุวรรณศาสตร อาจารยท่ีปรึกษารวมท่ีไดใหความชวยเหลือและสนับสนุนใน
การจัดทําโครงการในคร้ังนี้อีกท้ังยังคอยใหคําปรึกษาทางดานเอกสารโครงการท่ีมีขอผิดพลาด และ
แกไขใหสมบูรณ 
 ขอกราบขอบพระคุณคุณพอคุณแมและครอบครัวท่ีใหกําลังใจและสนับสนุนดาน
การศึกษาคนควาขอมูลการทําโครงการคร้ังนี้สุดทายนี้ขอบคุณสมาชิกในกลุมท่ีคอยใหความ
ชวยเหลือมาโดยตลอดจนโครงการสําเร็จตามวัตถุประสงคไดเปนอยางดี 
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คํานํา 

 
 โครงการนี้เปนสวนหน่ึงของวิชาโครงการ ตามหลักสูตรประกาศนียบัตรวิชาชีพช้ันสูง
(ปวส.) สาขาวิชาคอมพิวเตอรธุรกิจ เปนการนําความรูท่ีไดศึกษามาสรางเปนผลงานทางวิชาการ 
โดยคณะผูจัดทําไดเลือกท่ีจะทําโครงการประเภท ส่ือการเรียนการสอน  Adobe Illustrator CS6 
 การทําโปรแกรมฐานขอมูลจะบอกถึงการจัดการฐานขอมูลตางๆเกี่ยวกับส่ือการเรียนการ
สอนจะประกอบไปดวยแบบฝกหัดกอนเรียน เนื้อหาการสอนใชโปรแกรมและ แบบฝกหัดหลัง
เรียน 
 ทางคณะผูจัดทําโครงการน้ีหวังเปนอยางยิ่งวาระบบฐานขอมูลส่ือการเรียนการสอน  
Adobe Illustrator CS6 จะมีประโยชนตอผูอ่ืนไมมากก็นอย หากเอกสารประกอบโครงการเลมนี้มี
ขอผิดพลาดประการใดทางคณะผูจัดทําตองขออภัยมา ณ ท่ีนี้ดวย 

 
คณะผูจัดทํา 

23 มกราคม  2562 
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บทที่ 1 
บทนํา 

 
1.1 ภูมิหลังและความเปนมา 

         ทุกวันนี้โลกของเรามีการพัฒนาอยางตอเนื่องไมวาจะในดานเศรษฐกิจ การบริหาร หรือ
การเรียนรูในหองเรียน ซ่ึงในทุกๆดานลวนแตมีการใชส่ือมาชวยในการนําเสนอขอมูลเพื่อใหผู
ท่ีรับการนําเสนอสามารถเขาถึงขอมูลตางๆไดงายยิ่งข้ึน โดยการนําเสนอขอมูลนั้นมีรูปแบบ
ตางๆไมวาจะเปนในรูปแบบบทความตาราง กราฟ หรือรูปแบบ Animation หรือการนําเสนอ
ขอมูลในรูปแบบภาพเคล่ือนไหว โดย Animation คือ การสรางภาพเคล่ือนไหวโดยการฉาย
ภาพนิ่งหลายๆ ภาพตอเนื่องกันดวยความเร็วสูง อีกท้ังการใชคอมพิวเตอรกราฟกในการ
คํานวณสรางภาพจะเรียกการสรางภาพเคล่ือนไหวดวยคอมพิวเตอร  หากใชเทคนิคการถายภาพ
หรือวาดรูป หรือ หรือรูปถายแตละขณะของหุนจําลองท่ีคอย ๆ ขยับ จะเรียกวา ภาพเคล่ือนไหว
แบบการเคล่ือนท่ีหยุด หรือ สตอปโมชัน (stop motion) โดยหลักการแลว ไมวาจะสรางภาพ 
หรือเฟรมดวยวิธีใดก็ตาม เม่ือนําภาพดังกลาวมาฉายตอกันดวยความเร็ว ต้ังแต 16 เฟรมตอ
วินาทีข้ึนไป เราจะเห็นเหมือนวา ภาพดังกลาวเคล่ือนไหวไดตอเนื่องกัน ท้ังนี้เนื่องจากการเห็น
ภาพติดตา  
          ปจจุบันไดมีการนําเสนอการสอนในดานตางๆผานการทําวีดีโอและ Animation แลวแชร
ลงในอินเตอรเน็ตเพื่อใหบุคคลท่ัวไปสามารถนําไปใชและสามารถหาเทคนิคท่ีเหมาะสมใน
การแกไขปญหาเกี่ยวกับส่ิงท่ีเราสนใจได  ดังนั้นกลุมของขาพเจาจึงมีความสนใจท่ีจะสงตอ
ความรูท่ีกลุมของขาพเจามีในเรื่อง Adobe Illustrator CS6 โดยการนําเสนอการสอนผานการทํา 
Animation ซ่ึงโปรแกรม Adobe Illustrator CS6 นั้นคือโปรแกรมโปรแกรมที่ใชในการวาดภาพ 
โดยจะสรางภาพที่มีลักษณะเปนลายเสน หรือท่ีเรียกวา Vector Graphic จัดเปนโปรแกรมระดับ
มืออาชีพท่ีใชกันเปนมาตรฐานในการออกแบบระดับสากลสามารถทํางานออกแบบตางๆ ได
หลากหลาย ไมวาจะเปนส่ิงพิมพ บรรจุภัณฑ เว็บ และภาพเคล่ือนไหวตลอดจนการสรางภาพ
เพื่อใชเปนภาพประกอบในการทํางานอ่ืนๆ เชน การตูน ภาพประกอบหนังสือ เปนตน                                          
        ดังนั้นคณะผูจัดทําจึงไดมีความคิดเห็นรวมกันในการทําส่ือ Animation เพื่อสงตอความรู
ท้ังหมดในเร่ือง Adobe Illustrator CS6 ใหแกบุคคลทั่วไปโดยการนําเสนอวิธีการทํางานของ
โปรแกรม วิธีการใชอุปกรณตางๆในโปรแกรม ตลอดจนการแกไขปญหาตางๆท่ีเกิดข้ึน
ระหวางการใชงานโปรแกรม 
 



1.2 วัตถุประสงคโครงการ  
1. เพื่อสอนใหรูและเขาใจในโปรแกรม Adobe Illustrator CS6  มากข้ึน 
2. เพื่อใชเปนส่ือการเรียนรูของเยาวชนนักศึกษาและบุคคลท่ัวไปในอนาคต  
3. เพื่อศึกษาการจัดทําโครงงานดานคอมพิวเตอรธุรกิจ  
4. เพื่อสรางส่ือการเรียนรูดวยโปรแกรม Adobe Illustrator CS6 

 
1.3 ขอบเขตการศึกษา  

1. มีการล็อกอินเขาระบบ 
2. มีแทรกเสียง 
3. มีแบบฝกหัดกอนเรียนและหลังเรียน 
4. มีเนื้อหาใหความรูเกี่ยวกับโปรแกรม Adobe Illustrator CS6 

 
1.4 ประโยชนท่ีคาดวาจะไดรับ 

1. ไดสอนใหรูและเขาใจในโปรแกรม Adobe Illustrator CS6  มากข้ึน 
2. ไดใชเปนส่ือการเรียนรูของเยาวชนนักศึกษาและบุคคลท่ัวไปในอนาคต 
3. ไดศึกษาการจัดทําโครงงานดานคอมพิวเตอรธุรกิจ 
4. ไดสรางส่ือการเรียนรูดวยโปรแกรม  Adobe Illustrator CS6 

              
 

 
 
 
 
 
 



1.5 แผนการดาํเนนิงาน (Gantt Chart)  

     
ตารางท่ี 1.1 แผนการดําเนนิงาน (Gantt Chart) 

 

รายการ ภาคเรียนท่ี 1 มิถุนายน 61 กรกฎาคม 61 สิงหาคม 61 กันยายน 61 ระยะเวลา
1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4  

อบรมการทําโครงการนักศึกษา 
ปวช.3 และปวส.2 

                11-22 มิถุนายน 61

เสนอหัวขอ ATC.01โครงการ 
รอบท่ี 1 (บทท่ี1) 

                24-29 มิถุนายน 61

ประกาศผลหัวขอโครงการ รอบท่ี 
1 

                3  กรกฎาคม 61 

เสนอหัวขอโครงการ รอบท่ี 2                 4-6  กรกฎาคม 61

ประกาศผลหัวขอโครงการ รอบท่ี 
2 

                9  กรกฎาคม 61

สงบทท่ี 2                 18-25 กรกฎาคม 
61 

สงบทท่ี 3                 1-17 สิงหาคม 61 

สอบหัวขอโครงการ  
(รอบเอกสาร) 

                20-24 สิงหาคม 61 

ประกาศผลสอบ                 29 สิงหาคม 61 

สงความคืบหนาโปรแกรม  
50% 

                10-16 กันยายน 61 

สงความคืบหนาโปรแกรม 60%                 17-23 กันยายน 61 

สงความคืบหนาโปรแกรม 70%                 24-30 กันยายน 61 

รายการ ภาคเรียนท่ี 2 
พฤศจิกายน 61 ธันวาคม 61 มกราคม 62 กุมภาพันธ 62 ระยะเวลา 
1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4  

สงความคืบหนา 90%                 2 พฤศจิกายน 2561 

สงความคืบหนา 100%                 9 พฤศจิกายน 2561 

สอบโปรแกรม ระดับปวส.2                  10 พฤศจิกายน 
2561 

สอบโปรแกรม ระดับ ปวช.
3                 24 พฤศจิกายน 

2561 
สงบทที่ 4                  11-21 ธันวาคม 61 

สงบทที่ 5                 14-26  มกราคม 
62 

สงรูปเลม ซีดี และคาเขาเลม                 27 มกราคม –  
3  กุมภาพันธ 2562



1.6 เคร่ืองมือท่ีใช 
1. โปรแกรม Adobe Illustrator CS6 ของบริษัท Adobe Systems ใชในการวาดรูปและลงสี 
2. โปรแกรม Adobe Photoshop CS6 ของบริษัท Adobe Systems ใชในการตัดและแตงภาพ 
3. โปรแกรมAdobe Flash Professional CS6 ของบริษัท  Adobe Systems ใชในการสราง

ภาพเคล่ือนไหว 
 

1.7 งบประมาณการดําเนินงาน  
 
ลําดับ รายการ จํานวน ราคา 

1 กระดาษ A4 1 รีม 190 
2 คาปร้ินเอกสาร 80 แผน 500 
3 เขารูปเลม 1 เลม 250 

รวมเปนเงิน 940 
 

ตารางท่ี 1.2 งบประมาณการดําเนินงาน 
 
 
 
 
 
 
 
 
 
 
 
 



 
บทที่ 2 

ระบบงานและทฤษฎีที่เกี่ยวของ 
 

2.1 ระบบงานปจจุบัน  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 2.1 Flow chart ระบบงานปจจุบัน 

เริ่มตน

แบบทดสอบกอนเรียน 

สื่อการเรียนการสอน 

แบบทดสอบหลังเรียน 

จบการทํางาน



 
 

 
2.2 ปญหาท่ีเกิดขึ้นในระบบงานปจจุบัน 

1. แอนิเมช่ันท่ีมีอยูเดิมเปนเพียงส่ือวิดีโอท่ีดูไมนาสนใจ และยังไมคอยมีเปนส่ือการเรียนการ
สอนและยังไมมีแบบทดสอบ 

2. แอนิเมช่ันในรูปแบบส่ือส่ิงพิมพมีเนื้อหาบางสวนท่ีเขาใจยาก 
3. การเรียนการสอนจากในหนังสือเนื้อหาเขาถึงยากไมมีความนาสนใจ 
4. ภาพหรือเนื้อเร่ืองท่ีมีนั้นไมละเอียดพอท่ีจะทําใหผูเรียนหรือผูศึกษาเขาใจได 

 
2.3 การวิเคราะหความตองการระบบใหม 

1. แอนิเมช่ันท่ีจะพัฒนาข้ึนจะตองดูนาสนใจเปนส่ือการเรียนการสอน เนนทางเรื่องบทเรียน
และแบบฝกหัด 

2. การสรางแอนิเมช่ันใหมีการเขาถึงงาย เพื่อใหงายตอการเรียนรู 
3. การสรางแอนิเมช่ันท่ีทําใหผูท่ีตองศึกษาเกิดความสนใจและเรียนรูไดเขาใจงายมากข้ึน 
4. การสรางแอนิเมช่ันใหมีความครอบคลุมและละเอียดครบถวน สมบูรณถูกตองใหแกผูเรียน 

  
2.4 ทฤษฎีและระบบงานท่ีเก่ียวของ 

แอนิเมชัน (Animation) หมายถึง กระบวนการที่เฟรมแตละเฟรมของภาพยนตร ถูกผลิตข้ึน
ตางหากจาก กันทีละเฟรม แลวนํามารอยเรียงเขาดวยกัน โดยการฉายตอเนื่องกัน ไมวาจากวิธีการ 
ใชคอมพิวเตอรกราฟก ถายภาพรูปวาด หรือ หรือรูปถายแตละขณะของหุนจําลองท่ีคอย ๆ ขยับเม่ือ
นําภาพดังกลาวมาฉาย ดวยความเร็ว ต้ังแต 16 เฟรมตอวินาที ข้ึนไป เราจะเห็นเหมือนวาภาพ
ดังกลาวเคล่ือนไหวไดตอเนื่องกัน ท้ังนี้เนื่องจาก การเห็นภาพติดตาในทาง คอมพิวเตอร การจัดเก็บ
ภาพแบบอนิเมชันท่ีใชกันอยางแพรหลายในอินเทอรเน็ต ไดแกเก็บในรูปแบบ GIF MNG SVG 
และ แฟลช  คําวา แอนิเมช่ัน (animation) รวมท้ังคําวา animate และ animator มากจากรากศัพท
ละติน "animare" ซ่ึงมีความมหมายวาทําใหมีชีวิต ภาพยนตรแอนิเมช่ันจึงหมายถึงการสรางสรรค
ลายเสนและรูปทรงท่ีไมมีชีวิต ใหเคล่ือนไหวเกิดมีชีวิตข้ึนมาได)  

แอนิเมช่ัน  (Animation) หมายถึง "การสรางภาพเคล่ือนไหว" ดวยการนําภาพนิ่งมา
เรียงลําดับกัน  และแสดงผลอยางตอเนื่องทําใหดวงตาเห็นภาพท่ีมีการเคล่ือนไหวในลักษณะภาพ
ติดตา (Persistence of Vision) เม่ือตามนุษยมองเห็นภาพท่ีฉายอยางตอเนื่อง เรตินาระรักษาภาพนี้ไว
ในระยะส้ันๆ ประมาณ 1/3 วินาที หากมีภาพอ่ืนแทรกเขามาในระยะเวลาดังกลาว  สมองของมนุษย
จะเช่ือมโยงภาพ ท้ังสองเข าดวยกัน ทําให เห็น เปนภาพเคล่ือนไหวท่ี มีความตอเนื่ องกัน               
แมวาแอนิเมช่ันจะใชหลักการเดียวกับวิดีโอ แตแอนิเมช่ันสามารถนําไปประยุกตใชกับงานตางๆไ 

 



 
 

รูปท่ี 2.2 แอนิเมช่ันจากภาพวาดหลายๆภาพ 
 
มากมาย  เชนงานภาพยนตร  งานโทรทัศน  งานพัฒนาเกมส  งานสถาปตยงานกอสราง 

งานดาน-วิทยาศาสตร  หรืองานพัฒนาเว็บไซต  เปนตน 
 
ชนิดของแอนิเมชั่นสามารถแบงออกไดเปนสามชนิดคือ 
          1. Drawn Animation คือแอนิเมช่ันท่ีเกิดจากการวาดภาพหลายๆพันภาพ  แตการฉายภาพ
เหลานั้นผานกลองอาจใชเวลาไมกี่นาทีขอดขีองการทําแอนิเมช่ันชนดินีคื้อ มีความเปน
ศิลปะ  สวยงาม  นาดูชม  แตขอเสีย คือ ตองใชเวลาในการผลิตมาก  ตองใชแอนิเมเตอรจํานวนมาก
และตนทุนก็สูงตามไปดวย 
 

 
 
    รูปท่ี 2.3 ตัวอยาง แอนิเมช่ันภาพเสนและสี 2D 



 
 

      2. Stop Motion หรือเรียกวา Model Animation เปนการถายภาพแตละขณะของหุนจําลองท่ี
คอยๆขยับ อาจจะเปนของเลนหรืออาจจะสรางตัวละครจาก Plasticine วัสดุท่ีคลายกับดินน้ํามันโดย
โมเดลที่สรางข้ึนมาสามารถใชไดอีกหลายคร้ังและยังสามารถผลิตไดหลายตัว  ทําใหสามารถถายทํา
ไดหลายฉากในเวลาเดียวกัน  แตการทํา Stop Motmotion นั้นตองอาศัยเวลาและความทุมเทมาก เชน 
การผลิตภาพยนตรเร่ือง James and the Giant Peach สามารถผลิตได 10 วินาทีตอวันเทานั้น วิธีนี้เปน
งานท่ีตองอาศัยความอดทนมาก 

 
 
 
  
 
 
 
 
  

รูปท่ี 2.4 ตัวอยาง แอนเิมช่ันแบบ 3D 
 
 3. Computer Animation ปจจุบันมีซอฟตแวรท่ีสามารถชวยใหการทําแอนิเมช่ันงายข้ึน เชน 
โปรแกรม Maya, Macromediaและ 3D Studio Max เปนตน วิธีนี้เปนวิธีท่ีประหยัดเวลาการผลิตและ
ประหยัดตนทุนเปนอยางมาก เชน ภาพยนตรเร่ืองToy Story ใชแอนิเมเตอรเพียง 110 คนเทานั้น 
 
 
 
 
 
 
 

รูปท่ี 2.5 ตัวอยาง แอนเิมช่ันแบบ 3D 



 
 

2. ทฤษฎีการใชโปรแกรม 
2.4.2โปรแกรม Adobe Photoshop  

        เคร่ืองมือใน Photoshop เปนโปรแกรมตกแตงภาพทีไดรับความนิยมมาก เนื่องจากเปน
โปรแกรมท่ีใชงาย และรองรับ Application (Plug In) เสริมไดมากมาย 
       ลักษณะเดนของ Photoshop 
                1. Photoshop ทํางานเปน Layer 
ลักษณะการทํางานของ Photoshop จะเหมือนการวางแผนใสซอนๆ กัน เปนช้ันๆ โดยแตละแผนจะ
มีการทํางาน ตางกัน แตเมือรวมกันแลวจะเปนแคภาพภาพเดียว แตละแผนใส(Layer) สามารถสลับ
ไปมาได 

  
 
 
 
 
 

รูปท่ี 2.6  Photoshop ทํางานเปน Layer 
 

             2. รูปแบบคําส่ังเปนแบบ Interface Enhancement ไอคอนและปุมคําส่ังตางๆ จะอยูใน
รูปแบบของ Toolbox , Toolbar และ Dialog Box ซ่ึงจัดไวเปนหมวดหมู โดยกดคลิกเพื่อใชงาน 

 
 
 

 

 

 

 

รูปท่ี 2.7  แสดง รูปแบบคําส่ังเปนแบบ Interface Enhancement 



 
 

               3. สนับสนุนการทําการบนเว็บไซต  คือสามารถ  export ไดหลายนามสกุลไฟล 
เนื่องจากไฟลภาพท่ีใชบนเว็บไซตมีหลายประเภท และโปรแกรม Photoshop สามารถ สรางภาพท่ี
ใชงานบนเว็บไซตไดหลากหลาย 
                 เคร่ือง PC สําหรับใชงาน โปรแกรม Photoshop 
– ระบบปฏิบัติการ Windows XP – Windows 10 
– CPU เพนเทียม/amd 1 Ghz ข้ึนไป แรม 512 mb เปนอยางนอย (ยิ่งมากยิ่งด)ี 
– การดจอท่ีแสดงสีไดระดบั 16 bit ข้ึนไป 
– ควรใช จอภาพท่ีแสดงผลดวยความละเอียด 800*600 ข้ึนไป 

3. เร่ิมตนใชงาน Photoshop 
        1. วิธีการเขาสูโปรแกรม Photoshop  คลิกท่ีไอคอนโปรแกรมดังรูป    (ดับเบ้ิลคลิก ทีไอคอน
ดังรูปเพื่อเขาโปรแกรม Photoshop อาจมีรูปท่ีตางกันข้ึนอยูกับเวอรช่ันโปรแกรม) 

 

 

 

 

รูปท่ี 2.8 ไอคอนโปรแกรม 
 

 

 

 

 

 



 
 

2. หนาตาของโปรแกรม Photoshop 

 

รูปท่ี 2.9 หนาตาของโปรแกรม Photoshop 
 

 
 
  
 
 
 
 
 
 
 
 

รูปท่ี 2.10 หนาตาเคร่ืองมือของโปรแกรม Photoshop 
 



 
 

3 . Panel คืออะไร 
panel เปนแถบท่ีชวยอํานวยความสะดวกในการทํางาน ซ่ึงมีหลายแบบดวยกัน เชน panel Layer 
,History และ Navigator ซ่ึง panel ท่ีจําเปนในการใชงาน จะมีดังนี ้
1. Navigator ใชสําหรับขยายมุมมองการทํางานของพื้นท่ีการทํางาน 
2. History ใชสําหรับ การยอนกลับการกระทําตางๆ เม่ือผิดพลาด 
3. Layer ใชสําหรับการสรางและลบ layer ตางๆ 
วิธีการเปด/ปด Panel 
สามารถทําไดโดยไปที่เมนู Windows > แลวเลือก Panel ท่ีตองการใช 

 

 

 

 

 

รูปท่ี 2.11 หนาตาของ Panel 
ชนิดไฟลในโปรแกรม Photoshop 

.psd (Photoshop File) : เปนไฟลพื้นฐานของโปรแกรม Photoshop สามารถเก็บบันทึกขอมูล 
คุณลักษณะตางๆ ท่ีใชใน Photoshop ไมวาจะเปน Layer , สี หรือ Effect ตางๆ 
.bmp (Bitmap file) : เปนไฟลพื้นฐานของ Windows 
.gif (Graphic Interchange) : เปนไฟลท่ีใชกันมากบนอินเตอรเน็ต เพราะงายตอการบีบอัดขอมูล 
เพราะ มี 
ขนาดเล็ก และยังเปนไฟลท่ีใชทําภาพเคล่ือนไหวสวยๆไดดวย 
.jpg (Joint Photographic experts Group) : เปนไฟลนยิมใชบนอินเตอรเน็ตเชนกนัจะแตกตางกนั
ท่ีไฟลนี้ จะ 
มีความละเอียดของภาพคอนขางชัดเจน 



 
 

4. การเปดไฟล 
การเรียกไฟลภาพหรือไฟล psd นําข้ึนมาใชสามารถทําไดโดย ไปท่ีเมนู File > Open หรือคียลัด 
Ctrl+O  

 

 

 

 

 

รูปท่ี 2.12 การเรียกไฟลภาพหรือไฟล psd 
 

การเปดไฟลกอนหนานีด้วยคําส่ัง Open Recent ไปท่ีเมนู File>Open Recent แลวเลือกไฟลทีเคย
เปดไวอยูแลวไดจากคําส่ังนี ้

 

 

 

 

 

รูปท่ี 2.13 การเปดไฟลกอนหนานีด้วยคําส่ัง Open Recent 
 



 
 

5. การสรางภาพใหม 
นอกจากการนาํภาพมาใชงานแลวเราสามารถสรางภาพข้ึน มาใหดวยพืน้ท่ีการทํางานท่ีเราสรางได
เองดวย โดยการไปท่ีเมนู File>New หรือคียลัด Ctrl+N 

 

 

 

 

 

 

รูปท่ี 2.14 การสรางภาพใหม 
 

รายละเอียดการกําหนดขนาดพื้นท่ีใหม 

 

 

 

 

 

 

รูปท่ี 2.15  รายละเอียดการกาํหนดขนาดพ้ืนท่ีใหม 



 
 

การบันทึกไฟล 
การบันทึกไฟลของ Photoshop มีสองแบบคือ บันทึกเพื่อนํามาแกไขไดภายหลัง และบันทึก
นําไปใชงานบเว็บไซต 
1. การบันทึกงานเพ่ือนํามาแกไขภายหลัง สามารถทําไดโดย ไปท่ีเมนู File>save as… 
2. วิธีการเซฟนําไปใชบนเวบ็ไซต สามารถทําไดโดย การไปท่ีเมนู File > Save for Webจะปรากฏ
แถบขอมูลการ Save for Web ใหเลือกตามลําดับเลยครับ 
 

 
การใชเคร่ืองมือ Selection (Marquee Tool) ใชในการเลือกสวนของรูปภาพเพื่อการคัดลอกหรือ
ใสeffect ตางๆ ใหกับสวนท่ีเลือก และมักใชกับ คําส่ัง Copy , Cut ,Delและ คําส่ัง paste 

 

 

 

 

 

รูปท่ี 2.16  การใชเคร่ืองมือ Selection (Marquee Tool) 

 

 

 

 

 



 
 

การใชเคร่ืองมือ Selection (Lasso Tool)เปนการเลือกสวนของรูปภาพเชนกนั แตจะเปนการเลือก
แบบอิสระสามารถกําหนดสวนท่ีเลือกไดเอง 

 

รูปท่ี 2.17  การใชเคร่ืองมือ Selection (Lasso Tool) 

 

การใชเคร่ืองมือ Magic wand tool 

 

รูปท่ี 2.18 การใชเคร่ืองมือ Magic wand tool 

เปนการ Selection โดยอาศัยคาสีท่ีใกลเคียงกัน โดยโปรแกรมจะเลือกสีท่ีมีความคลายกับสีท่ีเลือก 

 

 



 
 

การใชเคร่ืองมือในการระบายสีหรือแกไขภาพ 
Healing Brush Toolใชเกล่ียรอยตางๆ โดยจะทําการรักษาโทนสี ความสวางใหใกลเคียงกับของเดิม
อัตโนมัติ เวลาใชตองกด ปุม Alt รวมดวย 

การใช Brush Tool  

 

รูปท่ี 2.19 เคร่ืองมือ Brush Tool 

 

รูปท่ี 2.20  เคร่ืองมือ Brush Tool 

 

 

 



 
 

การใชเคร่ืองมือในการคัดลอก Clone Stamp Tool 

 

รูปท่ี 2.21 เคร่ืองมือ Brush Tool 

 

 

รูปท่ี 2.22  เคร่ืองมือ Brush Tool 

เปนการใชเพื่อการคัดลอกบางสวนของภาพใหเหมือนตนฉบับเดิม ตองกดปุมA lt รวมดวย 

 

 

 

 



 
 

การใช Paint Bucket Tool ใชสําหรับการเติมสีลงวัตถุท่ีตองการ 

 

 
รูปท่ี 2.23  การใช Paint Bucket Tool  

 

การลบวัตถุดวย Eraser Tool ใชในการลบวัตถุท่ีตองการ 

 
รูปท่ี 2.24  การลบวัตถุดวย Eraser Tool  



 
 

เคร่ืองมือในการพิมพตัวอักษร สามารถพิมพขอความหรือตัวอักษรได จาก Type Tool 

 

 

 

รูปท่ี 2.25  เคร่ืองมือในการพมิพตัวอักษร  

 

เคร่ืองมือในการวาดรูปทรง Shape Tool 

 

รูปท่ี 2.26 เคร่ืองมือในการวาดรูปทรง Shape Tool 

 



 
 

การเลือกสีโดยใช Eyedropper Tool 
การเลือกสีโดยใช Eyedropper นั้นเปนการเลือกสี ท่ีเราไมทราบเฉดสีท่ีแนนอนทําใหยากตอการ
เลือกเราจึงใชเคร่ืองมือนี้ในการดูดเฉดสีทีเราตองการจากตนฉบับโดยใชเคร่ืองมือนีไ้ด 

 

รูปท่ี 2.27  การเลือกสีโดยใช Eyedropper Tool 
 

การเลือกสี Foreground และ Backgroud เปนเคร่ืองมือท่ีใชสําหรับการเลือกสีท่ีตองการ 

 

รูปท่ี 2.28  การเลือกสี Foreground และ Backgroud  
 



 
 

การทํา Effect ใหกับ Layer 
การเติม Effect ตางๆใหกับ Layer และรูปภาพ เชน การใสเสนขอบ การทําตัวนูน การใสเงา ฯลฯ 
สามารถทําไดโดย การไปท่ีเมนู Layer > Layer Style > แลวเลือก effect ท่ีตองการ 
 

 
 

รูปท่ี 2.29 การทํา Effect ใหกับ Layer 
 
 
 
 
 
 
 
 
 
 
 



 
 

4. ทฤษฎีสี 
สีเปนส่ิงท่ีมีความสําคัญตอวิถีชีวิต นับแตสมัยดึกดําบรรพจนถึงปจจุบัน ไดนําสีมาใชให

เกิดประโยชนโดยใชเปนสัญลักษณในการถายทอดความหมายอยางใดอยางหนึ่ง สีจึงเปนส่ิงท่ีควร
ศึกษาเพื่อใชประโยชนกับวิถีชีวิตของเราเพราะสรรพส่ิงท้ังหลายท่ีแวดลอมตัวเราประกอบไปดวยสี
ท้ังส้ินในงานศิลปะสีเปนองคประกอบสําคัญอยางหนึ่งและในวิถีชีวิตของเราสีเปนองคประกอบท่ีมี
อิทธิพลตอ ความรูสึก อารมณ และจิตใจแมสี ประกอบดวย  สี แดง สีเหลือง และสีน้ําเงิน ซ่ึงเม่ือนํา
แมสีท้ังสามมาผสมกันในอัตราสวนตาง ๆ ก็จะเกิดสีข้ึนมามากมาย ซ่ึงประโยชน จากการท่ีเรานํา
สีมาผสมกันทําใหเรา สามารถเลือกสีตาง ๆ มาใชไดตามความพอใจ สรางสรรคผลงานศิลปะท่ี
งดงามตามความพอใจขอผูสรางสีท่ีเกิดจากการนําเอาแมสีมาผสมกัน เกิดสีใหมเม่ือนํามาจัดเรียง
อยางเปนระบบรวมเรียกวาวงจรสี 

 
 
 
 

 
 

 

 

รูปท่ี 2.30 ภาพแสดงวงจรของสีท่ีเกิดจากการนําแมสีมาผสมกัน 
 
 
 
 
 

 
 
 
 
 
 



 
 

การเกิดสีดังภาพ เกิดจากการนําเอาแมสีมาผสมกัน ในอัตราสวนตางๆกันซ่ึงสรุปไดดังนี้ 
สีข้ันท่ี1 (Primary Color)   คือสีพื้นฐานมีแมสี 3 สี 

1. สีพื้นฐานแมสี 
 

 
 

 

 
รูปท่ี 2.31 สีพื้นฐานแมสี 

 
1.  แดง  
2.  สีเหลือง  
3.  สีน้ําเงิน  
สี ข้ันท่ี  2 (Binary Color) คือสี ท่ี เกิดจากการนําเอาสีข้ันท่ี  1 หรือแมสีมาผสมกันใน

อัตราสวนเทากันจะทําใหเกิดสีใหม 3 สีไดแก 
1.  สีเขียว เกิดจากการนําเอา สีเหลือง กับ สีน้ําเงิน มาผสมกันในอัตราสวนเทา ๆ กัน 
2.  สีสม  เกิดจากการนําเอา สีเหลือง กับ สีแดง มาผสมกันในอัตราสวนท่ีเทา ๆ กัน 
3.  สีมวง เกิดจากการนําเอา สีน้ําเงิน กับ สีแดง มาผสมกันในอัตราสวนท่ีเทา ๆ กัน 

สีข้ันท่ี 3 (Intermediate Color) คือ สีท่ีเกิดจากการผสมกันระหวางสีของแมสีกีบสีข้ันท่ี 2 จะเกิดสี
ข้ึนอีก 6 สีไดแก 

 
 

 
 

รูปท่ี 2.32  สีเหลืองแกมเขียว 
 

- สีเหลืองแกมเขียว เกิดจาก การผสมกันระหวางสีเหลืองกับสีเขียวอยางละเทาๆ 
 
 
 



 
 

 
 

 
 

รูปท่ี 2.33 สีน้ําเงินแกมมวง 
 

 - สีน้ําเงินแกมมวง เกิดจากการผสมกันระหวางสีน้ําเงินกับสีมวงอยางละเทาๆกัน  
 
 

รูปท่ี 2.34  สีแดงแกมมวง 
 

- สีแดงแกมมวง เกิดจากการผสมกันระหวางสีแดงกับสีมวงอยางละเทาๆกัน  
 
 
 
 
 

รูปท่ี 2.35  สีแดงแกมสม 
 

- สีแดงแกมสม เกิดจากการผสมกันระหวางสีแดงกับสีสมอยางละเทาๆกัน  
 
 
 

รูปท่ี 2.36  สีเหลืองแกมสม 
 

- สีเหลืองแกมสม เกิดจากการผสมกันระหวางสีเหลืองกับสีสมอยางละเทาๆกัน  
 
 
 

รูปท่ี 2.37 สีน้ําเงินแกมเขียว 
             - สีน้ําเงินแกมเขียวเกิดจากการผสมกันระหวางสีน้ําเงินกับสีเขียวอยางละเทาๆกัน 
 

 



 
 

คุณลักษณะของสีมี 3 ประการ คือ 
- สีแทหรือความเปนสี(Hue) หมายถึงสีท่ีอยูในวงจรสีธรรมชาติท้ัง 12 สี 

สีท่ีเราเห็นอยูทุกวันนี้แบงเปน 2 วรรณะ โดยแบงวงจรสีออกเปน 2 สวน จากสีเหลืองวนไปถึง 
สีมวง คือ 
 - สีรอน (Warm Color) ใหความรูสึกรุนแรงรอนต่ืนเตนประกอบดวย สีเหลืองสีมวง  
สีเหลืองสม สีสม สีแดงสม สีแดง สีมวงสม 
 - สีเย็น (Cool Color) ใหความรูสึกเย็นสงบสบายตาประกอบดวย สีเหลือง สีเขียวเหลือง สี
เขียว สีน้ําเงินเขียว สีน้ําเงิน สีมวงน้ําเงิน สีมวงเราจะเห็นวา สีเหลือง และสีมวง เปนสีท่ีอยูไดท้ัง 2 
วรรณะ คือเปนสีกลาง เปนไดท้ังสีรอน และสีเย็น 
 
ความเขมของสี (Intensity)  

เกิดจาก สีแท คือสีท่ีเกิดจากการผสมกันในวงจรสี เปนสีหลักท่ีผสมข้ึนตามกฎเกณฑและ
ไมถูกผสมดวยสีกลางหรือสีอ่ืน ๆ จะมีคาความเขมสูงสุด หรือแรงจัดท่ีสุด เปนคาความแทของสีท่ี
ไมถูกเจือปน เม่ือสีเหลานี้ อยูทามกลางสีอ่ืน ๆ ท่ีถูกผสมใหเขมข้ึน หรือออนลง ใหมืด หมน หรือ
เปล่ียนคาไปแลว สีแทจะแสดงความแรงของสีปรากฏออกมาใหเห็น อยางชัดเจน ซ่ึงจะทําใหเกิดจุด
สนใจข้ึนในผลงานลักษณะเชนนี้ เหมือนกับ ดอกเฟองฟาสีชมพูสด หรือบานเย็น ท่ีอยูทามกลางใบ
เฟองฟาท่ีเขียวจัด ๆ หรือ พลุท่ีถูกจุดสองสวางในยามเทศกาล ตัดกับสีมืด ๆ ทึบ ๆ ของทองผายาม
คํ่าคืน เปนตน 

 
น้ําหนักของสี  (Value)  

เปนการใชสีโดยใหมีคาน้ําหนกัในระดับตาง ๆ กัน และมีสีหลาย ๆ สี ซ่ึงถาเปนสีเดียว ก็จะ
มีลักษณะเปนสีเอกรงค การใชคาน้ําหนักของสี จะทําใหเกิดความกลมกลืน เกิดระยะใกลไกล ต้ืน
ลึก ถามีคาน้ําหนักหลาย ๆ ระดับ สีก็จะกลมกลืนกันมากข้ึนแตถามีเพียง1 - 2 ระดับท่ีหางกัน จะทํา
ใหเกิดความแตกตาง 
 
ความรูสึกของสี 

การใชวรรณะรอนเชนสีแดงสม ทําใหเกิดความรูสึกอบอุน ทาทาย เคล่ือนไหวส่ิงตาง ๆ ท่ี
เราสัมผัสดวยสายตา จะทําใหเกิดความรูสึกข้ึนภายในตอเรา ทันทีท่ีเรามองเห็นสี ไมวาจะเปน การ
แตงกาย บานท่ีอยูอาศัย เคร่ืองใชตาง ๆ แลวเราจะทําอยางไร จึงจะใชสีไดอยางเหมาะสม และ
สอดคลองกับหลักจิตวิทยา เราจะตองเขาใจวาสีใดใหความรูสึกตอมนุษยอยางไร ซ่ึงความรูสึก
เกี่ยวกับสีสามารถจําแนกออกไดดังนี้ 
 



 
 

รูป สี ความหมาย 
 สีแดง ใหความรูสึกรอนรุนแรง กระตุน  ต่ืนเตน เราใจ ความอุดมสมบูรณ

ความม่ังค่ัง ความรัก 

 สีสม ใหความรูสึก รอน มีชีวิตชีวา วัยรุน ความคึกคะนอง การปลดปลอย 
ความเปร้ียว การระวัง 

 สีเหลือง ใหความรูสึกแจมใส ความสดใส ความราเริง ความมีชีวิตใหม ความสุข 

 สีเขียว ใหความรูสึกสงบ เงียบ รมเย็น การพักผอน การผอนคลาย ธรรมชาติ 
ความสุขุม เยือกเย็น 

 สีน้ําเงิน ใหความรูสึกสงบเงียบ สุขุม สุภาพ ละเอียด สงางาม มีศักดิ์ศรี เปน
ระเบียบถอมตน 

 สีมวง ใหความรูสึก มีเสนห นาติดตาม มีอํานาจความรัก ความเศราความสงบ 
ความผิดหวัง ความสูงศักดิ์ 

 สีฟา ใหความรูสึก ปลอดโปรงโลง กวาง เบา โปรงใส สะอาด ปลอดภัย 
ความสวาง 

 สีดํา ใหความรูสึก มืด ลึกลับ ความส้ินหวัง จุดจบ ความตาย โหดราย อดทน
หนักแนน เขมแข็ง  มีพลังความเศรา 

 สีชมพู ใหความรูสึกอบอุน ออนโยน นุมนวล ออนหวาน ความรัก ความนารัก 
ความสดใส 

 สีเทา ใหความรูสึก เศรา อาลัย ทอแท ความลึกลับ ความหดหู ความชรา สุขุม
ความสงบ ความเงียบ สุภาพ ถอมตน 

 สีทอง ใหความรูสึก ความหรูหรา โออา มีราคา สูงคา ส่ิงสําคัญ ความม่ังค่ัง
ความเจริญรุงเรือง  

 
ตารางท่ี 2.1 ความรูสึกของสี 

 



 
 

สีกับการออกแบบ 
ผูสรางสรรคงานออกแบบจะเปนผูท่ีเกี่ยวของกับการใชสีโดยตรงมัณฑนากรจะคิดคนสี

ข้ึนมาเพ่ือใชในงานตกแตงคนออกแบบฉากเวทีการแสดงจะคิดคนสีเกี่ยวกับแสง จิตรกรก็จะคิดคน
สีข้ึนมาระบายใหเหมาะสมกับความคิดและจินตนาการของตนแลวตัวเราจะคิดคนสีข้ึนมาเพื่อความ
งามความสุขสําหรับเรามิไดหรือสีท่ีใชสําหรับการออกแบบนั้นถาเราจะใชใหเกิดความสวยงามตรง
ตามความตองการของเรา มีหลักในการใชกวางๆ อยู 2 ประการ คือ การใชสีกลมกลืนกันและการใช
สีตัดกัน  

การใชสีกลมกลืนกัน การใชสีใหกลมกลืนกันเปนการใชสีหรือน้ําหนักของสีใหใกลเคียง
กันหรือคลายคลึงกันเชน การใชสีแบบเอกรงคเปนการใชสีสีเดียวท่ีมีน้ําหนักออนแกหลายลําดับ
การใชสีขางเคียงเปนการใชสีท่ีเคียงกัน 2 – 3 สี ในวงสี เชน สีแดง สีสมแดง และสีมวงแดง การใช
สีใกลเคียงเปนการใชสีท่ีอยูเรียงกันในวงสีไมเกิน 5 สี ตลอดจนการใชสีวรรณะรอนและวรรณะเย็น 
(warm tone colors and cool tone colors) ดังไดกลาวมาแลว  

การใชสีตัดกัน สีตัดกันคือสีท่ีอยูตรงขามกันในวงจรสี การใชสีใหตัดกันมีความจําเปนมาก
ในงานออกแบบ เพราะชวยใหเกิดความนาสนใจในทันทีท่ีพบเห็น สีตัดกันอยางแทจริงมีอยูดวยกัน
6 คูสีคือ  

- สีเหลือง ตรงขามกับ สีมวง 
- สีสม ตรงขามกับ สีน้ําเงิน 
- สีแดง ตรงขามกับ สีเขียว 
- สีเหลืองสม ตรงขามกับ สีมวงน้ําเงิน  
- สีสมแดง ตรงขามกับ น้ําเงินเขียว 
- สีมวงแดง ตรงขามกับ สีเหลืองเขียว  

การใชสีตัดกัน ควรคํานึงถึงความเปนเอกภาพดวย วิธีการใชมีหลายวิธี เชน ใชสีใหมี
ปริมาณตางกัน เชน ใชสีแดง 20 % สีเขียว 80% หรือ ใชเนื้อสีผสมในกันและกันหรือใชสีหนึ่งสีใด
ผสมกับสีคูท่ีตัดกันดวยปริมาณเล็กนอยรวมท้ังการเอาสีท่ีตัดกันมาทําใหเปนลวดลายเล็ก ๆ สลับกัน 
ในผลงานช้ินหนึ่ง อาจจะใชสีใหกลมกลืนกันหรือตัดกันเพียงอยางใดอยางหนึ่งหรืออาจจะใชพรอม
กันท้ัง 2 อยาง ท้ังนี้แลวแตความตองการและความคิดสรางสรรคของเราไมมีหลักการหรือรูปแบบท่ี
ตายตัวในงานออกแบบหรือการจัดภาพหากเรารูจักใชสีใหมีสภาพโดยรวมเปนวรรณะรอน หรือ
วรรณะเย็นเราจะสามารถควบคุมและสรางสรรคภาพใหเกิดความประสานกลมกลืนงดงามไดงาย
ข้ึนเพราะสีมีอิทธิพลตอ มวล ปริมาตร และชองวางสีมีคุณสมบัติท่ีทําใหเกิดความกลมกลืน หรือ
ขัดแยงได สีสามารถขับเนนใหใหเกิดจุดเดน และการรวมกันใหเกิดเปนหนวยเดียวกันไดเราใน
ฐานะผูใชสีตองนําหลักการตางๆของสีไปประยุกตใชใหสอดคลองกับเปาหมายในงานของเรา
เพราะสีมีผลตอการออกแบบคือ 



 
 

- สรางความรูสึกสีใหความรูสึกตอผูพบเห็นแตกตางกันไปทั้งนี้ข้ึนอยูกับประสบการณและ
ภูมิหลังของแตละคนสีบางสีสามารถรักษาบําบัดโรคจิตบางชนิดไดการใชสีภายในหรือภายนอก
อาคารจะมีผลตอการสัมผัสและสรางบรรยากาศได 

- สรางความนาสนใจสีมีอิทธิพลตองานศิลปะการออกแบบจะชวยสรางความประทับใจ
และความนาสนใจเปนอันดับแรกท่ีพบเห็น 

- สีบอกสัญลักษณของวัตถุซ่ึงเกิดจากประสบการณหรือภูมิหลัง เชนสีแดงสัญลักษณของ
ไฟหรืออันตรายสีเขียวสัญลักษณแทนพืชหรือความปลอดภัยเปนตน 

- สีชวยใหเกิดการรับรูการออกแบบตองการใหผูพบเห็นเกิดการจดจําใจรูปแบบแลผลงาน 
หรือเกิดความประทับใจ การใชสีจะตองสะดุดตา และมีเอกภาพ 
ระบบงานท่ีเก่ียวของ 

นายอมฤทธ์ิ จิตนา และนายอนุสรณ บุญมา (2560) โครงการแอนิเมช่ัน เร่ืองการศึกษา
ช้ินสวนภายนคอมพิวเตอร การจัดทําโครงการช้ินนี้ข้ึนมาเพื่อใหบุคคลท่ัวไปรูจักกับคอมพิวเตรโดย
นําเสนอเปนส่ือประสมอยางผสมผสานท้ังภาพและเสียง และอักษรเปนแอนิเมช่ัน โดยใชโปรแกรม 
Adobe Flash CS5.5  ในการสรางแอนิเมช่ันนี้ข้ึนมา  
 นายธีรพัทร   คงสกุล และนายรัตนพล   รุงแสง (2560) โครงการแอนิเมช่ัน เร่ืองส่ือการ
เรียนการสอนเร่ือง ทองโลกอวกาศ2 การจัดทําโครงการน้ีข้ึนมาเพ่ือใหประโยชนความสนุก
เพลิดเพลิน และขอคิดดีๆ กับทุกคน ทางคณะผูจัดทําไดมีการพัฒนาตนเองเกี่ยวกับการใชโปรแกรม
ตางๆ ในการสรางแอนิช่ันใหออกมาดูดีและสมบูรณ 

นายธนากฤต  แถนสีแสงและนายวิศรุต  สุวรรณอําภา(2560) โครงการแอนิเมช่ันเร่ืองการ
สรางภาพเคลื่อนไหวดวยโปรแกรม Adobe Flash CS6 การจัดทําโครงการนี้ข้ึนมาเพื่อใหนักเรียน 
นักศึกษาไดความรูเกี่ยวกับคอมพิวเตอร สามารถนําไปใชไดตามวัตถุประสงคท่ีกําหนดไว 
ตลอดจนผูจัดทําสามารถบูรณการความรู ทักษะในรายวิชาตางๆ ท่ีไดศึกษาในสาขาวิชา พาณิชยการ 
สาขางานคอมพิวเตอร เพื่อนํามาสรางสรรค พัฒนานวัตกรรมใหม มีประโยชนโดยผูเรียนสามารถ
นําความรูจากการไดเขามาศึกษาไดนําไปเผยแพรตอบุคคลอ่ืน 

 
2.5 การนําคอมพิวเตอรเขามาใชในระบบ 

1. โปรแกรมAdobe Flash Professional CS6 ของบริษัท Adobe Systems ใชในการสราง
ภาพเคล่ือนไหว 

2. โปรแกรม Adobe Photoshop CS6 ใชในการตัดตอภาพ 
3. โปรแกรม Adobe Illustrator CS6 ของบริษทั Adobe Systems  

ใชในการวาดรูปและลงสี 
 



 
 

ดูรายช่ือผูจัดทําหรือทํา
แบบทดสอบ

คณะผูจัดทํา 

 

บทที่ 3 

การออกแบบระบบงานดวยคอมพิวเตอร 
 

3.1 การออกแบบระบบการทํางาน(Flow Chart)            
        

 

 
 

 
  

 

 

                                           

         

          

 

 

 

  

  

รูปท่ี 3.1 การออกแบบระบบการทํางาน(Flow Chart) 

 

เขาสูบทเรียน 

ทําความรูจักโปรแกรม Adobe 
illustrator  CS6 

แถบเคร่ืองมือในโปรแกรม

ประโยชนของโปรแกรม

แบบทดสอบหลังเรียน 

ออกจากระบบ

เมนู 

ผูจัดทํา

เร่ิมตน

ลงทะเบียน

แบบทดสอบกอนเรียน 



 
 

3.2  การออกแบบแผนภาพบริบท 

Context Diagram 

 

                

 

              0 

              แอนิเมช่ัน 
               ส่ือการเรียนการสอน 

               Adobe Illustrator CS6 
 
 
 
 

รูปท่ี 3.2 การออกแบบแผนภาพบริบท 

 

 

 

 

 

 

 

แอดมิน ผูใช 

ขอมูลสื่อการเรียนการสอน 

รายละเอียดส่ือการเรียนการสอน

เนื้อหาส่ือการเรียนการสอน

รับชมสื่อการเรียนการสอน 

ไดรับความรู 



 
 

3.3 การออกแบบ Storyboard 

 
รูปท่ี 3.3 แสดงหนาลงช่ือเขาใช 

 

 

 

 

 

 

 

 

รูปท่ี 3.4 แสดงหนาเมน ู

 

 



 
 

 

 

 

 

 

 

 

รูปท่ี 3.5 หนาเครดิตหนาท่ี 1 จะแสดงผูจดัทําโครงการ 

 

 

 

 

 

 

 

 

รูปท่ี 3.6 แสดงหนาแบบฝกหัดกอนเรียน 

 

 



 
 

 

 

 

 

 

 

 

รูปท่ี 3.7  แสดงหนาผลคะแนน 

 

 

 

 

 

 

 

 

รูปท่ี 3.8  แสดงหนาเขาสูบทเรียน 

 

 

 



 
 

 

 

 

 

 

 

 

รูปท่ี 3.9 แสดงหนาตัวเลือกบทเรียน 

 

 

 

 

 

 

 

 

 

 



 
 

3.4 การออกแบบส่ิงนาํเขา (Input Design) 

1. หนาแรก 
2. แอนิเมช่ัน เร่ือง ส่ือการเรียนการสอนโปรแกรม Adobe Illustrator CS6 
3. แสดงหนาเมนู 
4. ขอมูล กิจกรรม และผูจัดทํา 
5. แบบทดสอบ 

 

3.5 การออกแบบส่ิงนาํออก (Output Design) 

1. จอภาพแสดงสื่อการเรียนการสอน 
2. CPU ในการประมวลผล 
3. เคร่ืองปร้ินเอกสาร 

 

 

 

 



 
 

 
บทที่ 4 

การพัฒนาระบบสื่อการเรียนการสอน Adobe Illustrator 
 

4.1 เคร่ืองมือและอุปกรณท่ีใช 
1.  CPU = Intel ®Pentium® CPU B940 
2.  RAM = 4 GB. 
3. การดจอ = 2G DDR3 
4.  Keyboard 
5.  Mouse 
6.  Printer Cannon รุน ip2770 
7. จอโปรเจ็กเตอร 
8. จอภาพ 
 

4.2 โปรแกรมท้ังหมดท่ีใชในการพัฒนา 
1. โปรแกรม Adobe Illustrator CS6 ใชในการวาดและลงสีรูปภาพ 
2. โปรแกรม Adobe Photoshop CS6 ใชในการตกแตงภาพ 
3. โปรแกรม Format Factory  นํามาใชในในการแปลงไฟลเสียง 
4. โปรแกรม Microsoft Word  นํามาใชในในการทํา Flowchart 

  
 
 
 
 
 

 
 
 
 



 
 

 
4.3 การติดตั้งโปรแกรมและระบบ 
 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 4.1 Double Click file ช่ือวา Set-up.exe ท่ีเราโหลดไว 

 

 

 

 

 

 

 

 

 

รูปท่ี 4.2 มีการตรวจสอบ บางเคร่ืองอาจจะตองมีการ restart เคร่ืองใหมอีกคร้ัง แลวแตกรณ ี



 
 

 

 

 

 

 

 

 

 

รูปท่ี 4.3 ใหเลือก ขอ 2 TRY เพื่อติดต้ังโปรแกรม 

 

 

 

 

รูปท่ี 4.4  คลิกคําวา Accept 



 
 

 

 

รูปท่ี 4.5 ใหจํา สถานท่ีเก็บไฟลคือ c:\Program files\Adobe จากนั้นกด Install 

 

 

 

 

รูปท่ี 4.6 รอจนกวาแถบโหลดจะเต็ม 

 



 
 

 

 

รูปท่ี 4.7 เม่ือติดต้ังเสร็จ ใหกด Close 

 
 
 
4.4 วิธีการใชงาน 

  
 
 

 
 
 
 
 
 
 
 

 
รูปท่ี 4.8  แสดงการเขา My computer 

 



 
 

 
 

 
 

 
 
 
 
 
 

 
 

รูปท่ี 4.9 แสดงการเขา Data D 
 

 
 
 

 

 
 

 
รูปท่ี 4.10 แสดงการเปดไฟล Learning Adobe Illustrator CS6 

 



 
 

 
 

 

 

 

 

 

 

รูปท่ี 4.11 แสดงหนา  Loading กอนเขาชม 

 

 

 

รูปท่ี 4.12 แสดงหนา เขาสูระบบ 
 

 



 
 

 

 

 
 

 

 

 

 
 

รูปท่ี 4.13 แสดงหนา Menu 
 
 
 
 

 

 

 

 

 

 

รูปท่ี 4.14 แสดงหนาแบบทดสอบกอนเรียน 

 



 
 

 

 

รูปท่ี 4.15 แสดงหนาผลคะแนน 
 

 

 

 
 
 
 
 
 
 

 
รูปท่ี 4.16 แสดงหนาเลือกบทเรียน 

 
 

 



 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 4.17 แสดงหนาหา บทเรียน 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 4.18 แสดงหนาเลือกบทเรียน 
 
 



 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 4.19 แสดงหนาเลือกบทเรียน 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 4.20 แสดงหนาเลือกบทเรียน 
 
 



 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
รูปท่ี 4.21 แสดงหนาแบบทดสอบหลังเรียน 

 
 
 
 
 
 

 

 

 

 

 
รูปท่ี 4.22 แสดงหนาผูจดัทํา 

 
 



 
บทที่5 

สรุปผลการทําโครงการ 
 

5.1 สรุปผลโครงการ 
5.1.1 สรุปผลโครงการ 

1. จัดทําแอนนิเมช่ัน ในหัวขอ ส่ือการเรียนการสอน  Adobe Illustrator CS6 
2. ศึกษาการใชโปรแกรม Adobe Illustrator CS6 ใชในการวาดและลงสีรูปภาพ 
3. ศึกษาการใชโปรแกรม Adobe Photoshop CS6 ใชในการตกแตงภาพ 
4. ศึกษาการเขียนภาษา PHP 
5. ศึกษาการเขียนโปรแกรมเช่ือมตอฐานขอมูลดวยภาษา PHP 
6. ศึกษาการออกแบบส่ือการเรียนการสอนดวยAdobe Flash CS6 
 

              5.1.2 ขนาดของโปรแกรมแตละไฟลแจงใหทราบท้ังหมด 
ลําดับท่ี ชื่อไฟล ขนาด หมายเหตุ 

1 Learning Adobe Illustrator CS6 77,591 KB ไฟลโปรแกรมส่ือการเรียนการสอน 
 

ตารางท่ี 5.1 แสดงขนาดของไฟลโปรแกรม 
                
              5.1.3 ขอผิดพลาดท่ีมีตอการออกแบบระบบงาน 

1. มีระบบงานบางอยางท่ีไมสามารถทําได 
2. มีการเปล่ียนแปลงระบบงานบอยคร้ัง 
3. ส่ือท่ีมีอยูไมสวยงามจึงตองออกแบบงานใหม 

 
 
 

 
 
 



 
 

              5.1.4 ขอผิดพลาดท่ีมีในโปรแกรม 
1. การแสดงผลตัวหนังสือบางคร้ังไมข้ึนหรือผิดเพี้ยน 
2. การเปดงานในคอมพิวเตอรบางเคร่ืองอาจไมมีโปรแกรมสําหรับใชเปดส่ือการ

สอน 
3. เกิดจากปญหาโคด Error ในการแสดงหนา Login และทําใหในการ Link ไม

สามารถทํางานได 
 
5.2  ปญหาและอุปสรรคในการดําเนินงาน 

1. สมาชิกกลุมมีเวลาไมตรงกัน จึงทําใหการเดินทางมาทํางานกันลําบาก 
2. ผูพัฒนายังขาดประสบการณในการพัฒนาระบบจึงทําใหใชเวลาในการศึกษามาก ทําให

การทํางานเกิดความลาชา 
3. การจัดวางขนาดของปุมไอคอนบางปุมมีขนาดไมเทากัน ทําใหรูปแบบงานไมสวย 
4. ในการทํางานสมาชิกในกลุมยังขาดการวางแผนจึงทําใหเกิดความผิดพลาด 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

5.3 แผนการดาํเนินงาน (Gant  t Chart) 
รายการ มิถุนายน 60 กรกฎาคม 60 สิงหาคม 60 กันยายน 60 ระยะเวลา 

1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 
อบรมวิชาโครงการ                 11-22 มิถุนายน 61 

เสนอหัวขอATC01
โครงการรอบที่ 1 
(บทท่ี1) 

                24-29 มิถุนายน 61 

ประกาศผลหัวขอ
โครงการ รอบท่ี 1 

                3  กรกฎาคม 61  

เสนอหัวขอโครงการ 
รอบท่ี 2 (บทท่ี1) 

                4-6  กรกฎาคม 61  

ประกาศผลหัวขอ
โครงการ รอบท่ี 2 

                18-25 กรกฎาคม 61 

สงบทท่ี 2                 1-17 สิงหาคม 61 

สงบทท่ี 3                 20-24 สิงหาคม 61 

สอบหัวขอโครงการ                 29 สิงหาคม  61 

สงความคืบหนา 50%                 10-16 กันยายน 61 

สงความคืบหนา 70%                 24-30 กันยายน 61 

รายการ พฤศจิกายน 60 ธันวาคม 60 มกราคม 61 กุมภาพันธ 61 หมายเหตุ 
1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 

สงความคืบหนา 
100% 

                9 พฤศจิกายน 61 
 

สอบโปรแกรมระดับ
ปวส.2 

                10 พฤศจิกายน 61 

สงโปรแกรมระดับ 
ปวช.3 

                24 พฤศจิกายน 61 

สงบทท่ี 4                 11-21 ธันวาคม 61 

สงบทท่ี 5                 14-26 มกราคม 62 

สงรูปเลม ซีดี 
และคาเขาเลม 

                27 ม.ค.- 3 ก.พ. 62 

ตารางท่ี 5.2  แผนการดําเนนิงาน (Gantt Chart) 

หมายเหตุ                           หมายถึง การวางแผนการดําเนินงานจริง            

                                                                                   หมายถึง การดําเนินงานจริง 



 
 

5.4 สรุปคาใชจายในการดาํเนินงานจริง 

ลําดับ รายการ จํานวน ราคา 
1 กระดาษ A4 1 รีม 190 
2 คา Print เอกสาร 100 แผน 500 
3 คาเขาเลม 1 เลม 250 
4 คาซีดี+กลองซีดี 1 50 
5 คาสกีนแผนซีดี 2 100 

รวมเปนเงิน 1,090 
ตารางท่ี 5.3 สรุปคาใชจายในการดําเนินงานจริง 

 
 
 
 
 

 



 
 

ประวัติผูจัดทํา 

 
      นายโยธิน  ชาญจารุจิตร เกิดเม่ือวันท่ี 11 มกราคม พ.ศ. 2537  
สํ าเร็จการศึกษาช้ัน มัธยมตอนตนจากโรงเรียน เทพศิ รินทร
สมุทรปราการ ปจจุบันกําลังศึกษาในหลักสูตรประกาศนียบัตร
วิชาชีพช้ันสูง(ปวส .)สาขาวิชาคอมพิวเตอรธุรกิจ อยู ท่ีวิทยาลัย
เทคโนโลยีอรรถวิทยพณิชยการ ปการศึกษา 2560 ปจจุบันอาศัย อยู
บานเลขท่ี 27/188  หมู 9 ต.บางเมืองใหม อ.เมือง จ.สมุทรปราการ 
10270 
เบอรโทรศัพท  090-976-9760 
E-mail : Newlovepare@gmail.com 
 

 
      นางสาวจรินทร  สมบุญรอด เกิดเม่ือวันท่ี 9 กรกฎาคม พ.ศ. 2534  
สําเร็จการศึกษาช้ันมัธยมตอนปลายจากโรงเรียนวัดทรงธรรม 
ปจจุบันกําลังศึกษาในหลักสูตรประกาศนียบัตรวิชาชีพช้ันสูง(ปวส.)
สาขาวิชาคอมพิวเตอรธุรกิจ อยู ท่ีวิทยาลัยเทคโนโลยีอรรถวิทย
พณิชยการ ปการศึกษา 2560 ปจจุบันอาศัย อยูบานเลขที่ 10/7  หมู 15 
ต.บางหัวเสือ อ.พระประแดง จ.สมุทรปราการ 10130 
เบอรโทรศัพท  083-431-0647 
E-mail : ying530971@gmail.com 
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ภาคผนวก 

- ใบเสนอขออนุมัติการทําโครงการระบบคอมพิวเตอรธุรกิจ (ATC.01) 
- ใบเสนออาจารยท่ีปรึกษารวมโครงการ (ATC.02) 
- ใบขอสอบปองกันโครงการระบบคอมพิวเตอรธุรกิจ (ATC.03) 
- รายงานความคืบหนาโครงการระบบคอมพิวเตอรธุรกิจ (ATC.04) 
- ใบบันทึกการเขาพบอาจารยท่ีปรึกษาโครงการ (ATC.05) 
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